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1. Introduction 
 

What is Climsoft? 

The Climsoft system is a suite of software which is specifically designed for storing climatic 
data in a secure and flexible manner, and for obtaining useful information using these data. 
Climsoft version 4 was developed using Microsoft Visual Basic.NET. The default database 
storage engine is the open source MariaDB which is a fork from MySQL. 

The Climsoft system comprises: 

 The database, which holds climatic data for multiple stations in a logical and flexible 
structure;  

 A Key-entry component, to allow users to add new data to the database in a secure and 
controlled manner; 

 Facilities for importing climatic data in various formats into the database e.g. Data from 
Automatic Weather Stations (AWS), CLICOM ASCII, NOAA GTS and Text Files; 

 Facilities for exporting climatic data in formats ready for use by many climate 
applications (e.g.: RCLIMDEX, CPT, GEOCLIM, INSTAT, R- INSTAT, ENACTS, etc.); 

 Management of images of paper records (paper archives) in support of Data Rescue 
(DARE); 

 Quality Control checking of data that has been loaded into the database;  

 A number of Products, application programs which use subsets of the data stored in the 
database to produce useful reports, summaries and diagrams; and  

 System management facilities for managing user access, operations monitoring, 
administering the database and for tailoring the functions of the system to local needs. 
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2. Installation 

2.1 System Requirements 

Hardware: 

The Climsoft system requires the following typical hardware specifications: 

Computer with processor speed of 1 GHz, 2 GB RAM and enough disk space for installation of 
application software and storage of database. A minimum of 20 GB disk space is 
recommended. More disk space will be required for storage of AWS data and images of paper 
records for Data Rescue. However, it would be ideal to store images of paper records on 
removable storage media like external hard drives or Network Attached Storage (NAS). 

Internet connection is also desirable. 

 

Software: 

 Microsoft Windows 7 or later, 64-bit Operating System (OS) is recommended for optimum 
performance of the database. Climsoft Version 4 is compatible with the following Windows 
Operating Systems: XP, Vista, Windows 7, Windows 8.x  and Windows 10; 

 Microsoft Office with Excel spreadsheet is required since Excel spreadsheet application is 
the default application for displaying data products from Climsoft;  

 Antivirus software; 

 Minimum.Net Framework 4.5 is required. This version of the .NET framework is packaged 
with the Climsoft setup package; 

 Climsoft installation setup. Can be downloaded from met-eLearning site. Registration may 
be required. 

 MariaDB/MySQL database system and Climsoft database scripts which are also supplied 
through Climsoft installer and will be copied into the subfolder called "dbase" in the 
installation path; 

 WRPlot software for Windrose plotting which will be copied into subfolder called "Bin" in 
the installation path. 
 

2.2 Installation Procedures 

Please ensure that your PC meets the hardware and software requirements before you install 
Climsoft. You must also have Windows Administrator privileges for you to be able install 
Climsoft. 

There are two setup packages for Climsoft, one for 32-bit Windows Operating System (OS) 
and the other for 64-bit OS. Choose the setup package that matches your Operating System. 

1. Run the setup executable file with elevated privileges. To do this, right click on the setup 
file and choose "Run as Administrator" on the pop-up menu. 

2.  "climsoftv4_bit32_setup.exe" is for 32 - bit OS and “climsoftv4_bit64_setup.exe" is for 
64-bit OS. The setup Wizard will guide you through the installation process. 
 

3. When the core Climsoft setup has been completed, a dialog with options for installing 
additional applications required by Climsoft will appear as shown in Figure 1 below. 

https://www.met-elearning.org/course/view.php?id=58#section-2
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Figure 1(a): Installation of additional applications 

You may uncheck the selected applications if they are already installed or you would wish to 
install them after Climsoft installation. If you choose to install them later then find their installers 
in the ‘bin’ folder of the installation path.  
 
If you choose the default selections the applications listed in the above dialog will be installed 
automatically in the order they are listed on the above dialog. However, if the version of 
Microsoft .Net Framework on your computer is very low and need to be upgraded, the 
system will prompt you to do the upgrade, below is an example of a typical error message you 
may get: 
 

 

Figure 1(b): Dot Net Framework Initialisation Error  
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If you get a warning showing that you have a newer version of one of these applications 
already, click the Close button to continue with the installation of the next application. Figure 
1(b) displays the dialog with a warning that a newer version of Microsoft Visual C++2010 
Redistributable has been detected on your machine, in this case, click the Close button to 
continue with the installation of the next application.  

 
Figure 1(c): Warning about newer version of Visual Studio Runtime 
 

When you get to the installation of MariaDB, and you reach the point of specifying the Port 
number for running the MariaDB Service, it is strongly recommended that you choose the 
Port 3308, this is the port number defined in the configuration file of Climsoft for connecting to 
the MariaDB database that comes with the Climsoft setup. If you choose a different number, 
you will need to reconfigure the connection to the database to make the port number the same 
as the one you have configured during the MariaDB setup. 
 
It is also important to note that the password that you define during the installation and 
configuration of MariaDB will be required when you login to Climsoft for the first time. 
 
NOTE: If prompted to restart the computer before all selected installations are complete, 
please choose "restart later" and then restart the computer when all installations are 
complete. 
 
If the installation of WRPlot appears to take too long to complete, check for a second 
installation dialog that may be minimized on the bottom of the task bar requiring your input. If 
that dialog is there, open it and respond as appropriate. 
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Although WRPLot is a freeware, you need a license key to activate this application. An initial 
license key which is valid for one year is contained in the file "WRPLot_license.txt" in the sub 
folder "Bin" in the Climsoft installation folder. To renew the licence you will need to visit the  
"Lakes Environmental" website at http: //www.weblakes.com/. This URL is also provided on 
the "About" box of the WRPlot application. 
 
If you need to install, or re-install MariaDB or WRPLot later, the installation files for these 
applications are contained in the "Bin" sub folder of the CLIMSOFT installation folder. 
 

2.3 Creating Climsoft Database in MariaDB  

After the successful installation of Climsoft and MariaDB (MySQL database engine), you need 
to run the script to create the Climsoft database at the MySQL Client prompt. 

 Follow the steps below to run the script: 

(i) Launch MariaDB Prompt from your Start Windows program by clicking on the MySQL 

Client (MariaDB 10.x) as shown in Figure 2. You can also type the name “MariaDB” in the 

search box.  Dialogs obtained may look different, depending on your Version of Windows. 

   
Figure 2: Launching the MariaDB Client 
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The dialog for entering the password then appears as shown in Figure 3. 

                     
Figure 3: Entering the password on the MariaDB Client Prompt 

 

Note that the user name is assumed to be “root”. (There is no provision for entering the 
username if you have launched the MariaDB Client Prompt as described above.) 

If you have entered the correct password i.e. the same password that you entered during the 
installation and configuration of MariaDB, the prompt then appears as shown in Figure 4. 

 
Figure 4: MariaDB Prompt after entering correct password 
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(ii) Assuming the script file for creating the CLIMSOFT V4 database is in the Path 

“C:\Program Files (x86)\ClimsoftV4\Dbase”  

Type the following command on the prompt: 

“Source C:\Program Files (x86)\Climsoftv4\Dbase\mariadb_climsoft_db_v4_all.sql” 

Then press the Enter key. (This assumes the script file for creating the Climsoftv4 database 

is in the Path “C:\Program Files (x86)\Climsoftv4\Dbase”) 

If you have typed the command correctly, the script will create the Climsoft Version 4 
databases: Two (2) databases are created, the operational database 
(mariadb_climsoft_db_v4) and the test database which contains data for testing purpose 
(mariadb_climsoft_test_db_v4). 

(iii) To check or verify that Climsoft Version 4 databases have been created in MariaDB 

database engine, type: “Show databases;” command in MariaDB Client Prompt and press 

the Enter Key. The 2 Climsoft databases will then listed together with other database 

schemas that come with MariaDB;  

 

2.4 Setup Users permission to Climsoft folder and sub folders 

The settings described in sections 2.4 and 2.5 apply to Climsoft versions up to 4.1.4. In the higher Climsoft 

versions settings permissions to Climsoft folder are no longer required. Dialogs in section 2.5 have also been 

modified as shown in section 2.6 

Those using Climsoft versions 4.1.4 and earlier are strongly recommend to setup access 
permissions to Climsoft installation folder and sub-folders as described in the following 
paragraphs: 

By default, Climsoft is installed in a protected Windows folder i.e.: “C:\Program Files” or 
“Program Files (X86)” for a 64-bit version of Windows". 

Climsoft users will require permission to update Climsoft configuration file that is located in the 
"Bin" sub folder of the Climsoft installation folder.  

For instance if the installation path is: C:\Program Files” or “Program Files (X86)” for a 64-bit 
version of Windows" then the "write permission" should be set to the sub folder "climsoftv4" 
and its subfolders located at “C:\Program Files” or “Program Files (X86)” for a 64-bit 
version of Windows" as follow: 

Step1: Go to "C:\Program Files" or "Program Files (X86)" for a 64-bit version of Windows"; 

Step 2: Right click on subfolder "climsoftv4" and select "Properties" then "Security"; 

Step 3: In the dialog that follows, select the users or group of users that will be running 
Climsoft; 

Step 4: Click on Full Control box then “Apply” and OK (Figure 5); 
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Figure 5: Setup user’s permission 

 

Step 5: If the user or group of users is not on the list, Click "Edit" then "Add" button followed 
by "Advanced" then "Find Now"; 

Step 6: Choose the right user in the list and click OK then Click on Full Control box then OK. 

NOTE: These instructions are also listed in paragraph 4 of the document “Readme_Climsoft_V4.txt” found in 

sub folder “bin” of the Climsoft installation folder. 
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2.5 Climsoft First Login for Climsoft Version 4.1.4 and earlier versions 

You are now ready to launch the Climsoft Version 4 application. Double click the Climsoft icon 

on the desktop to launch the Climsoft Version 4 application and login (Figure 6). On the first 

login, the username must be “root”.  

 
Figure 6: Climsoft Version 4 Login Dialog 

 

(iv) If you are sure you have typed the correct password but have been denied access, click 

twice (not double click) on the blue label “Show and configure database connection…” 

on the above dialog to check the database connection details and adjust accordingly. Then 

a dialog similar to Figure7 appears. 

 
Figure 7: Database connection details 
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If the MariaDB database to which you want to connect is on your local computer then the 
server must be “localhost” or “127.0.0.1”. If the port number you chose during the installation 
of MariaDB is different from “3308” as shown on the screenshot above, you will need to 
change the port number to the one you used during the installation of MariaDB and click 
Update.  

After successful login, the Climsoft front-end will appear as shown (Figure 8). From the front-
end, you can access all the components of the Climsoft CDMS, either through the top menu or 
by clicking the icons on the Welcome screen.  

However, a user will be able to access only the features corresponding to the privileges 
associated with the user- group to which they belong to. 

2.6 Updated Climsoft Login and Database Connection 

2.6.1 Login Dialog 

 
Figure 6a : Climsoft Version 4.1.5 Login Dialog 

2.6.2 Database Connection Dialog 

 
Figure 7a: Database connection details  

To Login 

Enter user name in User Name box 

Enter Password in Password box 

 

To Change database connection 
Click twice on Manage database 

connections string 

 

To remember user name in 

subsequent logins 

Check the box Remember username 

To connect to any of the listed 

databases 

 Select the database by clicking on the 

left most cell of that row, 

 Click on the button Make default 

 Click OK to save changes and close 

the dialog 

 

To connect to a database that is not 

listed 

 Enter the database details in the new 

row (i.e *) 

 Follow the provided Example 

connections to fill all cells of that row 

 Click on the button Make default 

 Click OK to save changes and close the 

dialog 
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3. Climsoft Main Menu and Welcome Dialog 
 

After a successful Login the main interface for Climsoft Version 4 displays (see Figure 8). It is 
referred to as the Welcome Dialog and consists of the Main Menu and icons through which all 
the functionalities are accessed.  

 
Figure 8: Welcome Dialog 
 

The functions that are accessed from this dialog are as follows: 

3.1 Menu Bar 

 

 Input – Open key entry forms and the paper archive dialog; 

 Accessories – Open the calculation of Relative Humidity and Dew point, given the Dry; 
Bulb and Wet bulb temperature; 

 Products – Open the Climate data development dialog; 

 QC – Data quality control functions; 

 Administration – Functions for administration of users and the database. This feature 
is only accessible to administrators; 

 Change own password – Open the dialog for users to change their password; 

 Tools – Open dialogs for different operational settings; 
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 Language translation – Open the dialog for setting the language to be used in the user 
interfaces; 

 Help – About Climsoft V4 and online help on how to undertake various operations. 
 

3.2 Main Menu Icons 

 Data Entry – List key entry forms to enter climate data. Same as in the menu Input; 

 Data Transfer – Open a dialog for data upload, import (external data), backup and 
restore; 

 Users Administration – Open a dialog for adding users and updating their details. . 
Same as in the menu Administration; 

 AWS Real Time Processing – Open a dialog for setting and managing Automatic 
Weather Station (AWS) real time operations; 

 Archive Paper Image - Open a dialog for managing paper images. Same as in the 
Menu; 

 Quality Control checks - Open a dialog for quality control checks. Same as in the 
menu Input; 

 Climate Products - Open a dialog to extract climate products. Same as in the menu 
QC; 

 Metadata Information - Open the metadata management dialog; 

 Close – For Climsoft Shut down. 
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4. User Management and Configuration Settings  

4.1 User Management 

The default user of the Climsoft CDMS is “root”. This is the super user of the system with 
access to all the features of the Climsoft CDMS. To allow other users to make use of the 
system, the “root” user must add new users and assign them to different user groups. The 
different user groups that have been pre-defined for Climsoft are shown in Table1: 

User Group  Summarized access rights 

ClimsoftAdmin All Climsoft features including creating and deleting other users 

ClimsoftDeveloper Modification of all Climsoft features 

ClimsoftMetadata Updating of metadata e.g. station information, instruments, etc. 

ClimsoftOperator Key-entry of observation data 

ClimsoftOperatorSupervisor Key-entry plus uploading key-entry data to observationinitial 
table 

ClimsoftProducts Extracting products from Climsoft 

ClimsoftQC Key-entry, upload to observationintial and Quality Control 

ClimsoftRainfall Key-entry of only rainfall data 

ClimsoftTranslator Translation of text on controls and messages 

Table 1: CLIMSOFT user roles 

The “root” user or an administrator is able to access the user management dialog by clicking 
the “User Management” icon on the Welcome screen or via the “Administration” menu. The 
dialog for User Management is shown in Figure 9. 

 
Figure 9: Climsoft user management 
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The user management dialog is self-explanatory. The “Add New” button is enabled after filling 
all the text boxes and picking the user role from the dropdown list. 

After creating new users, the Climsoft administrator can change the password of any user via 
the “Administration” menu, any user can change his/her own password via the menu item 
“Change own password”. 

4.2 Configuring General Settings 

To customize Climsoft for local use, the Climsoft administrator must configure the system via 
Tools >> General Settings from the top menu on the Climsoft front-end. Figure 10a shows 
the dialog for configuring the general settings in a view displaying one record at a time.  

  
Figure 10 (a): General settings in single record view mode 

The screenshot in Figure 10a shows the default value for the folder for QC reports that will be 
generated from Climsoft. In Figure 10a, the folder name and path must match the folder and 
path on the computer where the Climsoft database has been installed. The folder name and 
path do not necessarily have to be the same as the default value shown in the screenshot. The 
“Update” button must be clicked for each setting (on each record) to take effect. 

IMPORTANT! 
In Figure 10a, the Administrator must navigate through all the records in the dialog and 
change the contents in the text box to the right of the label “Setting Value” to suit the required 
local configuration.  

Alternatively, by clicking the “View” button, the settings can be viewed and edited in datasheet 
(table) view as shown in Figure 10(b). 
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Figure 10 (b): General settings in datasheet view mode 

Read and understand the message in the information box the click OK to proceed. You may 
increase the columns width in the data sheet to see more details by dragging the columns 
boundaries to the right. With administrative privileges the records may be updated but not 
deleting or adding. Values in the column “KeyName” should not be changed because they are 
used by Climsoft to reference the selected record.  
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5. Metadata Management 
 

Climsoft uses metadata to describe the data archived in its database. It is therefore important 
to manage the metadata well and ensure all metadata data is in place before the data is 
loaded into the Climsoft database. The dialog shown in Figure 11 below facilitates 
management of all metadata in the Climsoft database. Each tab opens a dialog for the 
management of each metadata type.  

Figure 11: Metadata Management 

 

The dialog in Figure 11 is for the station metadata. All other metadata dialogs have a similar 
structure.  

The Station metadata dialog has the following controls. 

 Text boxes – For the input of metadata values or showing the values for the selected 
record; 

 Scroll bar – To navigate through the metadata records; 

 Searching records; 
o Search Station Name list box – Searches station for the selected name and 

displays its details in the text boxes 
o Station Id list box – Also searches by selecting the Station Id value. 
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 Latitude and Longitude MUST be entered in decimal degrees. However, a dialog to 
convert directly geographical coordinates in degrees, minutes and seconds (Latitude 
and Longitude in Degrees, Minutes and Seconds) into Degrees Decimal is provided. 
 

 Command Buttons: 
o AddNew – Adds a new metadata record after details have been typed in. The 

Station Id is mandatory and must be unique in all records; 
o Save – Adds and saves a new station record in the database whose details have 

been typed;  
o Update – Updates the changes made on the selected record; 
o Delete – Removes the selected record from the database; 
o View – Displays the metadata records in a tabular form. The Export button will 

export the metadata file in csv format; 
o Import – Opens a dialog through which stations metadata in a text (csv) can be 

imported into Climsoft. By clicking the Import Command button the dialog in 
Figure12 below appears; 

5.1 Importing Station Metadata 

 
Figure 12: Importing stations metadata 

 

The metadata import file can be created using EXCEL then saved as Comma Separated 
Values (CSV) with column headers. In EXCEL the structure is as shown in Figure 13; 
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Figure 13: structure of station metadata file in Excel 

After saving in a text (csv) format the data appears as shown in Figure 14. 

 
Figure 14: structure of station metadata file in Notepad. 
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5.1.1 Station Metadata Import procedure 

 From the Metadata Import dialog, Figure 12, open the text file containing the station 
metadata; 

 The column headers in the text file are listed in the Import Field Name column of the 
dialog; 

 For each field in the list click twice (not double click) on the Select Field to select the 
corresponding field name from the database; 

 Click the Import command. The metadata will then be imported and any station that 
fails to be imported will be listed in Errors message box with the cause of the failure. 
The summary of the importing will be listed below that box. 

 Scroll through the error messages, correct the text file and repeat the exercise. 
Duplicate error messages should be ignored since they indicate the record already 
exists in the database. 

 Click Close to exit the dialog. 

5.2 Other Metadata 

Other metadata do not require importing but are typed since they are usually few. 

5.2.1 Elements  

Observation elements are many and are supplied with Climsoft. They can be edited after 
clicking the Element tab to display the Observation Element dialog. This dialog enables the 
characteristics of a new climatic element to be specified and those of existing elements 
modified. Generally the elements will be standard, so the only modifications needed will be to 
the limits or the scale. 

The elements may be viewed and updated in either Element view, Figure 15, or in Table View, 
Figure 16. Click the View button in Figure 15 to move to the Table view.  In Table View, Click 
the View Mode button to return to the Element view of Figure 15. 
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Figure 15: Elements dialog 

The dialog in Figure 15 is used as follows: 

(i) Adding a new element record: 

 Click AddNew  to obtain a blank form; 

 Enter metadata values for the element;  

o Data for ID is mandatory and unique in all records, 

o Scale is the factor used in key entry for the decimal point. Therefore 
Upper Limit and Lower Limit values should take the scale into account, 

o Type is the frequency of observation e.g., minute, hourly, daily. 

 Click Save to add the new record in database. 

(ii) Updating (editing) existing element record: 

 Use either Search Element box or ID to locate the required element record, 

 Edit the desired values, 

 Click Update to save the changes. 

(iii) Deleting elements 

 Use either Search Element box or ID to locate the required element record 

 Click Delete 
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Alternatively move to Table View, Figure 16 and use the command buttons as described 
below; 

 
Figure 16: Elements in table view 

 

Use the commands as follows; 

 Delete: Delete the current record by selecting on clicking the left most cell, 

 Update: Updates changes made on the current (selected) record, 

 View Mode: Switches between View and Edit mode, 

 Export: Exports all the elements metadata into a text CSV file, 

 Close: Closes the view table, 

 Help: Online help on how to use this dialog. 

(iv) Selected elements 

This box is used to select the elements that will be listed in various dialogs where element 
list is required. Use this box and check (tick) for the required elements and uncheck 
(untick) for those that are not required. Remember to click the Update button whenever 
the box is checked or unchecked otherwise the action will not be saved.  

(v) Total Required 

  By default this box is unchecked (unticked).  The box is used to check for those elements 
whose sum for the observation values will require to be entered in the key entry forms. 
This action is purely for QC purposes where the sum of the entered values will be 
compared with the totals computed by the observer. Remember to click the Update button 
whenever the box is checked or unchecked otherwise the action will not be saved. 
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5.2.2 Station Element  

The details of the elements observed at a particular station are entered here: 

This dialog enables the editing and updating of element information as recorded at a particular 
station. Before adding a station element record in this dialog details about the stationId, 
elementId, instrumentId and scheduleclass that describes this element should be entered in 
their respective tables in that order. 

 
Figure 17: Station Element details 

5.2.3 Instruments  

This dialog enables the system administrator to specify the characteristics of a particular 
instrument used to record an element at a given station. 
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Figure 18: Instrument details 

5.2.4 Station Location History 

The detailed history of the station location are shown in the dialog in Figure 19. 

 
Figure 19: Station Location History 
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5.2.5 Station Qualifier 

The qualifier of the station are shown in the dialog in Figure 20. 

 
Figure 20: Station Qualifier 

5.2.6 Schedule Class 

Various observation schedule classes can be defined in Climsoft as shown in Figure 21. 

 
Figure 21: Schedule Class 
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5.2.7 Physical Feature 

The detailed Physical features of each station are shown in Figure 22.

 
Figure 22: Physical Features 

5.2.8 Paper Archive Definition 

Metadata definitions of the paper images to be archived are shown in Figure 23 This 
information should be entered before the paper archive record can be added. Paper archiving 
operation is described in Chapter 12. 

 
Figure 23: Paper Archive Definition 
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6. Key Entry 

Climsoft comes with a list of Key-entry forms for a user to choose the form that suits the set of 
data to be entered. To start, the Climsoft administrator selects only those forms required by the 
key entry operators. The following paragraph describes how this administration process is 
undertaken. 

6.1 Setting up Key Entry Forms List 

To access the list of all available key-entry forms, login as administrator and follow the steps 
below; 

 From the Welcome form click the menu Administration then Data Forms to obtain the 
dialog in Figure 24. 

 
Figure 24: Key Entry Forms Settings 

 Check the boxes for those forms to be shown and uncheck for those to hide, 

 Click Apply to save the changes and Cancel to close the dialog. 

6.2 Opening a Key Entry Form 

 From the Welcome form click on the icon Data Entry to obtain the dialog shown in Figure 
25; 
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Figure 25: Key Entry forms opening 

 Double click on the required form or select the form. Press the Enter key to open it, 

 Clicking OK also opens the selected form, 

 Select Cancel to close the dialog. 

6.3 Key Entry Forms Layout 

All key-entry forms in Climsoft have the same general layout. Figure 26 shows a sample 
screenshot of the form for entering hourly data. 

Just below the title bar, there are controls for header information associated with an 
observation, typically station identifier, date/time information and element identifier.  

Below the header area are text boxes for entering observation values, and near the bottom of 
the key-entry form is a data control for navigating through key-entry records.  

Further down are buttons for triggering various key-entry actions e.g. the action to enter a new 
record.  

When the “Add New” button is clicked, the header information for a selected form 
automatically moves to the next record to be entered.  
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Figure 26: Key Entry form for hourly data 

6.4 Key Entry Sequencer 

Assuming that the next element for which observation data will be entered is “Temp wet bulb” 
which is short form for wet-bulb temperature, then the value in the element list box will 
automatically change to “Temp wet bulb”. When the “Add New” button is clicked, the order in 
which the element abbreviation changes on the element list box is controlled by what is called 
a “sequencer” in Climsoft. There is therefore need to customize the order or sequence in 
which the element name changes on the element list box. The name of the sequencer for the 
key-entry form is displayed in the text box below the key-entry buttons on the key-entry form. 



 33 

For Hourly data, the required sequencer configuration is done on the appropriate dialog which 
is accessed via the top menu on the Climsoft front-end by clicking on Tools >>Sequencer 
configuration >>hourly. Figure 27 shows a screenshot of the dialog for configuring the 
sequencer for hourly data. The dialog is intuitive, with some guidelines in the top part of the 
form. 

 
Figure 27:  Dialog for configuring the sequencer for hourly data 

The dialog for configuring the sequencer for daily data is accessed via Tools >> Sequencer 
configuration >> Daily. A screenshot of the dialog is shown in Figure 28.  

 
Figure 28: Dialog for configuring sequencer for daily data 
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Similarly, the dialog for configuring the sequencer for monthly data is accessed via Tools >> 
Sequencer configuration >> Monthly. A screenshot of the dialog is shown in Figure 29.  

 
Figure 29: Dialog for configuring sequencer for monthly data 

In addition to the sequence of the elements, the date/time sequence is also changed 
automatically. This sequence does not require customization since it is the same for any 
location. 

6.5 Configuring synoptic hours for key entry 

The form for hourly data can also be used for entering data for selected synoptic hours. This is 
done by disabling the text boxes for non-synoptic hours by clicking the button “Enable 
synoptic hours only”. This button is located just below the header information on the hourly 
form. Figure 30 shows the hourly form when key-entry is enabled only for 3 hours. 
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Figure 30: Hourly form enabled just for synoptic hours 
 

When the button “Enable synoptic hours only” has been clicked, its label immediately 
changes to “Enable all hours”, so it allows toggling between “all hours” and “synoptic hours”. 
The dialog for configuring the specific synoptic hours that would be enabled is accessed via 
Tools >> FormHourly time selection. A screenshot of the dialog is shown in Figure 31. 
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Figure 31: Configuring synoptic hours to be enabled on hourly form 

6.6 Key Entry Operation 

It is a strict requirement in Climsoft to enter station information in the station table before the 
key entry operation is done. The same requirement applies to importing of external data. 
Hence update the station information before attempting any of these operations. See the 
metadata section for the necessary instructions. 

For key entry, it is also important to check the element information which comes with the 
Climsoft setup to ensure that all required elements are clearly defined and the element limits 
for QC are adjusted, where necessary, to meet local needs. 

To start key entry, click on the “Data Entry” icon on the Climsoft “Welcome” screen. Select the 
key entry form that corresponds to the data to be entered and double-click on the selected 
form.  
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The use of the key entry forms is quite intuitive, so there is no need for detailed guidelines 
except to highlight the common aspects that apply to all key-entry forms, and some features 
related to specific forms. 

 After selecting a value from a dropdown list e.g. a station name, or entering a value in a 
text box, the Enter key must be pressed for the value to be registered on the form and 
for the cursor to move to the next cell. 

 Some key entry forms have a provision for entering the “Total” for elements that require 
the sum of values for a particular column of observation data. The Climsoft 
administrator must configure the metadata in the element table to enforce the 
requirement for the total to be entered for the elements that need a total to be entered 
during key entry. 

 Some buttons are enabled or disabled depending on the situation. For example, the 
“Save” button is enabled only after clicking the “Add New” button to enter a new record. 
Then the same “Add New” button is automatically disabled until the “Save” button has 
been clicked to save data for the newly added record. 

 When the cursor leaves a particular text box or dropdown list after pressing the “Enter” 
key, quality control (QC) checks are carried out on the value that has just been entered. 
Figure 32 shows a QC message after entering a value that has failed the QC check for 
upper limits when entering daily data. 

 
Figure 32: QC checks during key entry 
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 All key-entry forms have an “Upload” button for transferring data from a key-entry table 
into a common table named “observationinitial” where more QC checks are carried out.  

 The Upload button is not enabled for a user with the role of operator, but is enabled for 
users with the role of operator supervisor, QC and administrator, 

 All key-entry forms have a “View” button for viewing the data that has been entered in 
datasheet view, Figure 32. To facilitate locating a required record, the rows are in 
ascending order by station ID, element ID, and date/time attributes, 

 In the datasheet view, a key-entry operator can delete or update own records in the data 
entry table using the Delete or Update command button if the “Edit Mode“ is active. To 
activate the “Edit Mode” simply click the command button “Edit Mode”,  

 The “Export” command button exports all the records entered in the data entry form in a 
csv file for further processing, 

 The “Import” command button import data that had been saved into a text file through the 
Export command.  Together Export and Import operations can act as backup and restore 
of data in key entry forms. The can also be used to transfer data between Climsoft servers, 

 An important feature of the datasheet view functionality is that in a network arrangement 
where multiple key-entry operators enter data into the same key-entry table from different 
workstations, a key-entry operator can only view and make changes to the data records 
that he/she has entered. Although navigation through all records entered is possible for all 
key-entry operators, “Delete” button is disabled for key-entry operators, but enabled for the 
and administrator. This is to minimize the chances of operators deleting each other’s data. 

Figure 33: Key entry datasheet view 
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6.6.1 Some special features for specific key entry forms 

 
(i) Just below the header area of the form for daily data shown in Figure 22, there is a section 

indicating units of measurement for some elements. This is to accommodate entering 
historical data over different periods where the units of measurement for those elements 
have changed. For example, old historical paper records in some National Meteorological 
and Hydrological Services (NMHSs) had units of degrees Fahrenheit for temperature 
which were later changed to degrees Celsius. Similarly, old records for precipitation could 
have units of inches which were later changed to millimeters. 
 

(ii) The form for daily data is designed for entering different elements, with the next element 
being changed automatically after clicking the “Add New” button, being controlled by the 
sequencer. However, sometimes only a single element is entered, especially for data from 
rainfall stations. In such cases, the element sequencer can be turned off by unchecking the 
“enable element sequencer” checkbox. 

 
(iii) The form for daily data has text boxes for entering observations values for each day from 

day 1 up to a maximum of day 31. If the value of the month entered in the header section 
of the month has a maximum number of days less than 31, text boxes associated with 
day numbers beyond the maximum number of days for that month are disabled. This 
applies to months with 30 days and also for February with 29 days for a leap year and 28 
days for a non-leap year. 

 
(iv) The daily form and the hourly form have a provision to assign the same value for all 

observation days for a particular element. This is most appropriate especially when 
entering rainfall values of zero for the whole month, thereby reducing the number of key 
strokes substantially. 

 
(v) As described under the section on “Configuring synoptic hours for key entry”, the 

hourly form can be configured for entering observation data for all hours or for selected 
synoptic hours. 

 
(vi) The form for entering hourly wind data provides for fast entering of wind direction and 

speed as one number in the same text box with the direction and speed automatically 
separated into different text boxes. The splitting of the combined wind value into direction 
and speed is based on the configured number of digits for direction and speed. This 
configuration described under “Configuring general settings”. This form also has 
provision for entering wind data for all hours or for selected synoptic hours, similarly to 
the configuration available on the hourly form.   
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Key entry form for hourly wind speed and direction 

Figure 34: Key entry form for hourly wind 

 
(vii) The form for entering synoptic data for an observation made up of many elements at the 

same hour of observation, shown in Figure 35, provides for the automatic calculation of 
derived elements, namely, mean sea level pressure, geopotential height, dew-point 
temperature and relative humidity. 

NOTE: The automatic calculation of mean sea level pressure and geopotential height require 
station elevation data to be available in the station metadata table. 
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Key entry form for Synoptic observations 

 
Figure 35: Key entry form for many elements observed at the same time 

 

 
 

(viii) The form for entering upper air observations is made up of many elements at the standard 
pressure levels namely Surface, 1000, 925, 850, 700, 500, 400, 300, 250, 200,150,100, 70, 50, 30, 

20,10 shown in Figure 35a. The key entry is sequenced in the order of Levels, Day, Month 
and Year. The observation elements for the upper air data should be configured as 
detailed in Table 2 below. However, the QC limits and units should be set according to the 
observation practice at the given centre 
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Key entry form for Upper Air observations 

 
Figure 35a: Key entry form for upper air observations at standard levels  
 

 
Element Id Abbreviation Element Name Description Element Type 

301 PRESS Pressure Level Pressure level Upper Air 
302 HEIGHT Height of Pressure Level Height of pressure level Upper Air 
303 TEMPDB Temp at Press Lvl Temperature at pressure level Upper Air 
304 DPTDEP Dew Point Depress at Press Lvl Dew point depression at pressure level Upper Air 
305 WNDDIR Wind Dir at Press Lvl Wind direction at pressure level Upper Air 
306 WNDSPD Wind Spd at Pressure Lvl Wind speed at pressure level Upper Air 
307 WNDSHR1B Wind Sheer 1km lyr blw Wind sheer 1km layer below Upper Air 
308 WNDSHR1A Wind Sheer 1km lyr abv Wind sheer 1km layer above at pressure level Upper Air 
309 LATHDISP Lat displ at pressure lvl Latitude Diplacement at Pressure Level Upper Air 
310 LONGHDISP Lon Displ at press lvl Longitude Diplacement at Pressure Level Upper Air 
311 ACCTMDISP Time Displ at press lvl Time Displacement at Pressure Level Upper Air 
312 ACCVERSIG Vert Signf at press lvl Vertical Signficant at Pressure Level Upper Air 
313 RELHUM RH at Press Lvl Relative Humidity at Pressure Level Upper Air 

Table 2: Upper observation elements details – To be configured in Elements Metdata 
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6.7 Empty Key Entry Tables 

This operation facilitates emptying of key entry tables. This is necessary to avoid the records 
growing to a point of slowing the key entry and data uploading processes. However, it should 
be ensured before emptying any table the data therein has been uploaded, quality controlled, 
errors corrected, uploaded to the final database table and is ready for products generation. 

This operation is undertaken through the dialog shown in Fig 36 as follows: 

(i) From the Main Menu click “Administration” -> “Empty Key Entry Forms”, 
(ii) On the Forms List check the box(s) for the form whose data is to be emptied. 
(iii) Select the records within the selected form that are to be deleted. Choose either the 

option “All Records” or “Selected Records”. In case of “Selected Records” enter the 
required time range in the relevant boxes, 

(iv) By default all the records that have not been uploaded to either “observationinitial” or 
“observationfinal” table but are within the selected option will not be deleted from the 
key entry table. But if it is felt that they can be deleted and may be re-entered later then 
uncheck the box “Skip Records Not Uploaded”. 

 
Figure 36: Dialog for Emptying Key Entry Forms 

6.8 Operational Monitoring 

During the key entry operation details of the operator are captured. They are login name and 
entry date time. These details can be used to monitor data entered by any operator. The 
operation is started through “Administration” -> “Operations Monitoring” to obtain the dialog 
similar to Figure 36. The tabs on the dialog describe the different processes undertaken in the 
monitoring operation. They are: 
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(i) User Records: See Figure 37. The Administrator can monitor records for a single 
operator or for all operators combined depending on the option selected. Any operator 
can monitor own records through Accessories -> User Records. In this case only the 
records for the current operator on that terminal that will be displayed. The Start Date 
and End Date should be appropriately selected then click View Records.  

(ii) Settings: The other 2 operations namely Performance Monitoring and Double Key 
Entry Verifications require some prior settings before they are undertaken. This is done 
through the tab “Settings” as described in section 6.8.2. 

6.8.1 Users Records 

 
Figure 37: Operations monitoring dialog 

6.8.2 Settings 
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Figure 38: Operations monitoring settings dialog 
 

To undertake any of the operation in this dialog select the option and click View to obtain a 
grid table from where the values are set as follows: 

 

 

 

 

 

(i) Target Records 

 
Figure 39: Target records setting 
 

Enter the target value for each operator against which the performance for the selected period 
will be measured then click Update. There should be a value for every operator listed. 

 

(ii) Data Entry mode: 

 
Figure 40: Data entry mode settings 

If any of the listed form requires to be set to double key entry status then the entry mode 
should be set to 1 and click Update. On reverse it should be set to 0. 
While in double entry mode data entered will be compared with the previous entry. Where the 
2 entries conflict the operator will be prompted for a repeat entry. A form that is set for double 
key entry will not accept any data that has not been previously entered. To enter new data the 
key entry mode has to be set back to 0 (single data entry). 
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6.8.3 Performance Monitoring 

Performance monitoring can be done on monthly basis or for a selected period of time. Select 
the appropriate option then click “Compute Performance”. Click “Save Output” to save the 
performance output to a CSV file. See the dialog in Figure 41. 

 
Figure 41: Data entry mode settings 

 

6.8.4 Double Key Entry Verification 

Where key entry has been set to double key entry mode it becomes necessary to verify which 
records have been repeated or otherwise. See Figure 42. The verification can be done for 
single form or all of them combined. From the dialog make the selections correctly then click 
“Retrieve”. The records that suit the selected criteria will be listed. Click “Save” to output the 
records in CSV file and opened in EXCEL. 
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Figure 42: Double key entry verification 
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7. Post Key Entry Quality Control Checks 

Climsoft provides a facility for further Quality Control (QC) checks on data that has been 
uploaded from key-entry tables or imported from external sources into the “observationinitial” 
table. The dialog for these QC checks, shown in Figure 43, is accessed by clicking the icon 
“Quality Control Checks” on the Welcome screen. 

 
Figure 43: Quality Control Checks 

The options for QC checks currently available are “Absolute limits checks” and “Inter-
element comparison checks”. 

The “Absolute limits checks” option is checked by default when the QC icon is clicked. After 
specifying the QC time range, selecting (by ticking) the stations  and elements which you want 
to QC, then click on  the “Perform QC” button, to generate the QC report output files in comma 
separated value(csv) format.  

Two output files are generated, one for the upper limits (e.g. 
qc_report_upperlimit_190001_201712.csv) and another for the lower limits (e.g. 
qc_report_lowerlimit_190001_201712.csv). The QC report filename give an indication of which 
type of QC report is being performed and the specific period of time. The filename is generated 
automatically after selecting the type of QC and time range for QC. 

If the specific stations and elements are not selected, the QC will be performed on all stations 
and elements in the “observationinitial” table. This is the same as selecting or ticking “Select 
All Stations” and “Select All Elements”. 

In the case of “Inter-element checks”, the QC checks are done by default on all the stations 
and elements or on specified stations and elements. Five output files in csv format are 
generated after specifying the QC time range and clicking on the “Perform QC” button.  Each 
file contains the report on related elements e.g. maximum and minimum temperatures 
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(qc_interelement_2_3_193001_193112.csv), dry and wet bulb temperatures 
(qc_interelement_101_102_193001_193112.csv), wet bulb and dew point temperatures, 
(qc_interelement_102_103_193001_193112.csv), maximum and dry bulb temperatures 
(qc_interelement_2_101_193001_193112.csv) and dry bulb and minimum temperatures 
(qc_interelement_101_3_193001_193112.csv). 

                  Figure 44: List of QC reports 

 

NOTE: 

The QC reports are saved in the folder configured for the QC reports under “General 
Settings”. Hence make sure that the folder for QC reports has been configured correctly. This 
folder must be on the computer where the MariaDB is running from. If the MariaDB server is 
being accessed over the network from a workstation, it would be ideal to map that folder on the 
workstation for easy access from the workstation. 

The name of the QC report is generated based on the type of QC selected and the specified 
period for the QC.  

For the inter-element QC checks, the codes of the elements that have failed the QC checks 
will also be included in the file name e.g. “qc_interelement_101_3_200101_200312.csv” 
indicates a report for inter-element checks between dry bulb temperature and minimum 
temperature from January 2001 to December 2003. 

A suffix “Updated” is added manually by the QC officer or administrator to show that the 
values in the QC report have been modified. Figure 45 shows the contents of a QC report for 
limits checks displayed in Excel spreadsheet. 

The report on the screenshot in Figure 38 shows two values of maximum temperature, 6.6 and 
6.4 that are below the lower limit of 12.0 for maximum temperature. The other useful 
information displayed is the station ID, element ID, date/time, the username of the person who 
entered the data and the key-entry form used for entering the data. 
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Figure 45: QC report showing values below lower limit 

Figure 46 shows a QC report for inter-element comparison. The report shows maximum 
temperatures (2) below dry bulb temperatures (101) for the same day. 

 
Figure 46: QC Report for inter-element comparison 

After analyzing a QC report and making any changes, the report with updated values should 
be saved with a different name. What is recommended is to add a suffix “updated”.  

7.1 Updating the database from a QC report 

To update the database from the QC report, the “Update With QC Report” button on the QC 
main dialog shown in Figure 43 should be clicked. When the “Update With QC Report” button 
has been clicked, the dialog in Figure 47 will appear, with provision to browse for the original 
QC report file and the updated report file. After clicking the “OK” button, the database is 
updated with the changes made in the QC report. 

 
Figure 47: Dialog for updating database from a QC report 



 51 

7.2 Transferring Data from “observationinitial” to “Observationfinal” table 

After quality control of the data in the “observationinitial” table, the QC’d data can be 
transferred to the “observationfinal” table from which products can be derived. The dialog for 
transferring data to the “observationfinal” table is accessed from the Welcome screen by 
clicking the “Data Transfer” icon, followed by clicking the menu “Upload” then “ObsInitial to 
Final” to open the dialog  shown in Figure48. 

                   
Figure 48: Upload data to observationfinal table 

By default, data for all the stations for the period specified in the time range (Begin Year, End 
Year, Begin Month, and End Month) are transferred into the “observationfinal” table. However, 
you can customize the transfer into “observationfinal”, by selecting the stations, the elements, 
and the time range (Begin Year, End Year, Begin Month, End Month). Click the “Upload” 
button to start the data transfer. The progress of data transfer is shown in the progress dialog. 

Only data that have gone through QC are uploaded to the “observationfinal” table. 
Observation records that have not yet been QC’d have a QC status flag of zero “0” while 
records that have been QC’d have a QC status flag of one “1”. 

 

7.3 Update Observations 

The Update Observations facility in Climsoft Version 4 enables users to view and update 
data in the intermediate and final stages of the archiving process. The administrator is able to 
use the “Update Observations” dialog to modify (view, correct, update and delete records in 
the database). The Update Observations   dialog has an option to delete many records at once 
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by selecting them, here the administrator needs to provide confirmation before the delete 
operation.  

The steps below show how to view, correct, update and delete data in the “observationinitial” 
or “observationfinal” database tables: 

Step 1: Login into Climsoft with a high privilege (e.g.: administrator); 

Step 2: From the main menu, select “Administration” then “Update Observations” to open 
the dialog; 

Step 3: Under “Tables”, select the table of your choice (Observation Initial or Observation 
Final); 

Step 4: Under “Records Selection”, fill the text box to specify the Station ID, the Element ID, 
the Start Year, the End Year, the Start Month and the End Month;  

Step 5: Under “Commands”, select “View” to view the records in data sheet view, Figure 49; 

Step 6: To correct a data in a cell, click on a particular cell containing data, change the value 
and click the “Update” command button to save the changes; 

Step 7: To delete the entire row or many rows, select them and click on the “Delete” command 
button; 

Step 8: Select the “Close” button to close the dialog and the “Help” button to get more help on 
the “Update Observations” procedures. 

 
Figure 49: Update Observations Dialog 
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8. Data Transfer Operations 

Data transfer operations involve importing and exporting data from different formats. The data 
transfer operations are: 

(i) Upload: Transfers quality controlled data from the table “observationinitial” to 
“observationfinal”. More details in Section 7.2, 

(ii) External Data: Imports text data files in formats such as; earlier Climsoft versions, 
CLICOM, Automatic Weather Station (AWS), NOAA GTS and any other text 
data in delimited texts files. More details in Sections 8.1 through 8.5, 

(iii) Backup: Makes a backup of all data in table “observationfinal” to text files. More details 
in Section 9.1, 

(iv) Restore: Restores Climsoft version 4 backup files back to the database. More details in 
Section 9.2. 

8.1 Data from Climsoft V3 – Data migration 

From the Welcome dialog click on the icon “Data Transfer” then “External Data” and ”Data 
Migration” to obtain the dialog in Figure 50. 

 
Figure 50: Data migration dialog 

8.1.1 Importing from Climsoft Version 3 MySQL Database 

This operation requires both Climsoft Version 3 database and Climsoft Version 4 database be 
installed in the same server.  

Data migration from V3 to V4 will then be carried out in the following steps; 

(i) Ensure the database names for both V3 and V4 are correctly typed (See Figure 50 above); 
(ii) Select the option Entire Database if the entire database is to be migrated, 
(iii)  Select the option Selected Records if only a range of data is to be migrated and 

provide the starting and the ending years appropriately, 
(iv) Check the box Replace Existing Records if any existing similar records are to be 

replaced. If Unchecked the duplicate records will be skipped, 
(v) Click Start command to start the process, 
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(vi) Observe any message reported in the Messages box and address them accordingly. 

8.1.2 Importing from CLIMSOFT V3 Backup 

Climsoft Version 3 backup files archived in text (csv) files are imported through this operation.  

The steps to be followed are: 

(i) Select the option Climsoft V3 Backup (see Figure 50 above), 
(ii) Through the explorer button  select the text backup file. The file name is then 

displayed in the box Backup File but wait for the messages; Climsoft V3 Backup 
converted to Climsoft V4 Structure, 

(iii) Check or uncheck the box Replace Existing Records appropriately, 
(iv) Click Start command to start the process, 
(v) Observe any message reported in the Messages box and address them accordingly. 

8.2 Importing CLICOM data 

From this operation the 3 CLICOM data formats namely CLICOM Daily, CLICOM Synop and 
CLICOM Hourly will be imported into Climsoft version 4. 

Figure 51 shows a screenshot of sample CLICOM daily data. The data format is similar to that 
for CLIMBASE. Users with data from CLIMBASE can follow the same procedure to import 
CLIMBASE data into CLIMSOFT. 

 
Figure 51: Sample CLICOM daily data 

To import CLICOM daily data, click on the “Data Transfer” icon on the Climsoft Welcome 
screen, followed by clicking on the menu items External Data ->CLICOM->Daily. This will 
open the dialog shown in Figure 52 below.  
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Figure 52: Importing CLICOM daily data 

To import CLICOM daily data click “Open File” then select the file containing the data and click 
“Open” on the file open dialog. Enter the hour for the daily data observation in the text box. 
“Default Observation hour” 06Z has been set as the default. Then from the import dialog click 
“View Data” and the grid table gets populated with the data.  Confirm that it’s the right data 
then click “Load Data”. Wait for the process shown in Figure 53 to complete with a message 
“Data import process completed”. CLICOM Synop and CLICOM Hourly data are similarly 
imported. 

 
Figure 53: CLICOM daily data import process 
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8.3 Importing Automatic Weather Station (AWS) data 

Before importing AWS data, it is important to note the structure or format of the AWS data. 
Many Automatic Weather Stations (AWS) are configured to produce data output files in ASCII 
format. However, AWS from different suppliers tend to have different observation data outputs 
depending on the sensors available and configuration of the output. Figure 54 shows a 
screenshot of sample data from an AWS installed in Rwanda. The first row contains the field 
column) headings representing different meteorological elements. In most cases, not all fields 
are required for data ingestion into the Climsoft database. 

Figure 54: Sample observation data from an AWS 

8.3.1 Selecting the import file and viewing the data 

Procedures: 

(i) Select the “Data Transfer” Icon from the main menu welcome dialog, 

(ii) Select “External Data” form the Database utilities menu, 

(iii) Select “AWS” to open import dialog shown as shown in Figure 55, 

(iv) Click on “Open File” to browse for the file to import, 

(v) After the file has been located, click “Open” in the file open dialog. The filename with 
its full path will then be shown in the Import File text box. See Figure 55, 

(vi) Select the “Delimiter” option that matches the data separator in the selected file. 
Selecting a wrong delimiter option will result in data not being properly imported, 

(vii) If some header rows are to be skipped while importing then, enter the row number 
where importing will start in the “Start Row” text box (Start Row: 2 is the default i.e. 
data starts at row 2 and row 1 contains the headers for the data columns), 

(viii) “Remove Scaling” is checked by default i.e. if the data in the file has been scaled to 
some decimal points then the decimal point will be removed during the transfer into 
“observationinitial” table. If the data in the file is not scaled to decimal points then the 
“Remove Scaling” box must be unchecked. 
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(ix) If all the data belongs to one station and that it does not have a column with station 
IDs, then type the ID for the station in the “Station ID” text box.; 

(x) After completing above steps click “View Data” to populate the grid view with the 
selected data. Note that only the first 25 rows of data from the selected file will be 
listed in the grid table. This is meant to enable confirmation that the right data has 
been selected. However, the entire file will be imported if everything is well selected. 

Note that the column headers in the grid table will be serialized with numbers from 1 up to 
the last column of that data. The following section outlines how to rename the column 
headers with the element codes for the data they represent. 

 
Figure 55: AWS Data Import 

8.3.2 Configuring column headers and uploading data into Climsoft database 

(i) Under “Columns Header Settings”, select the column number and click on the 
appropriate field name from the two boxes therein respectively. Do that for each column 
until all of them are done. Make sure the correct field names are selected in order for the 
data to be appropriately mapped in the database. If any column contains data that will not 
be imported it should be labeled “NA”, 

(ii) If the step (i) above is correctively completed then configured header specifications can 
be saved in a text file to be used later for a similar file without going through that process 
again. To save the specifications click “Save Header Specs” button and choose a 
convenient location and file. Note that the file will automatically be allocated file extension 
of sch e.g. aws1.csh; 
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(iii) If the header specs had been saved earlier click “Load Header Specs” and select the 
header specs file. If correctly selected the columns in the displayed data table will be 
automatically labeled with the header specs. 

If satisfied that the columns are correctly named click “Load Data” to start the uploading 
process. Wait until the busy mouse pointer changes to default. A message will be 
displaying at the bottom of the dialog in red showing the data transfer progress. 

It should be noted that the station IDs element codes used must described in the metadata. 
If not data described by them will not be imported. Station IDs and Element Codes not 
found in metadata will be listed at the bottom of the dialog. 

 
 Figure 56: Configuration of column headers 

8.4 Importing Text Files Data of Different Structures 

8.4.1 Hourly and Daily Data Import 

Daily/Hourly data values arranged in one or many columns can be ingested easily into Climsoft 
version 4. The data should be saved in delimited text files. Figure 57 and 58 are sample data 
files with data organized in different structures: 
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Figure 57: Sample file with data in one column 

 

 
Figure 58: Sample file with data in many columns 

Follow the steps below to transfer Hourly/Daily data with one or many columns structure into 
Climsoft version 4: 

(i) Select “Data transfer” icon from the welcome main menu dialog, 
(ii) Select “External Data” and select “Text Files” and then “Hourly or Daily” option, 

Figure 59, 
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Figure 59: Import External Data Dialog 

(iii) After selecting “Hourly or Daily” option, the dialog in Figure 60 displays. Click on “Open 
File“ to browse and select the file containing data to transfer, specify the “delimiter” of 
the file to import (e.g. comma (default), TAB, Others), tick/untick the “remove scaling” 
box appropriately to ensure data will be imported into “observationinitial” table without 
the decimal points and then select “View Data” to view the file in data sheet view 
(tabular form), 

(iv) Set the Columns Header by matching each data column by its corresponding field 
name, 

 
Figure 60: Importing External Data 
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(v) After finishing the matching you will have the dialog shown in Figure 61. 

 

Figure 61: Columns Header Settings 

(vi) Click the “Load Data” button to load the data into the “observationinitial” table and 
observe the records uploading count and the process completion message at the 
bottom of the dialog. In case the upload fails a message will pop up accordingly 

Note: To avoid setting the columns headers each time you load new data, save the columns 
header specifications by selecting the “Save Header Specs” button. Note the file extension 
(e.g. header1_specs.sch). 

To retrieve and use the saved columns headers select the ” Load Header Specs” button and 
navigate to select the appropriate file. 

8.4.2 Multiple Element Columns 

Figure 62 shows  a text (csv) file (opened in Excel) with the columns for StationID, Year, Month, 

Day and 5 columns with values of different Elements (i.e. Tmax, Tmin, RAIN, RAD and EVAP). This 
file can be easily imported in Climsoft V4 through the procedure described below: 
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Figure 62: Sample data with multiple columns 

The procedure to import this file is as follows: 

a) Selecting the import file and viewing the data 
(i) Select the “Data transfer” icon from the welcome dialog, 
(ii) Select “External Data”, then “Text Files” and then the “Multiple Element Columns” 

option (see Figure 59),  
(iii) Select Open File to browse the file to import, 
(iv)  After the file has been located, click Open in the file open dialog; the filename with its 

full path will be shown in the “Import File box”. See Figure 63, 
(v)  Select the Delimiter option according to the data separator for the selected file 

(comma, tab or others). 
(vi) If some rows are to be skipped while importing e.g. column headers enter the row 

number where importing will start in the “Start Row” box. Row 2 is the default, 
(vii) If the data does not contain the observation hour column, fill the “Default Observation 

Hour” box by entering the daily observation hour. The value 06 has been set as default 
as it is the case with most parameters, 

(viii) If the data in the file is scaled to some decimal point, then check the box Remove 
Scaling, 
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(ix) When all the above steps have been completed click View Data. The table in the dialog 
is then populated with the data from the selected file. The column header will be 
serialised with numbers from 1 up to the last column of that data, as shown in Figure 63. 

 
Figure 63: Multiple column data Import 

 

b) Configuring column headers and upload data to the Climsoft database 

(i) Under “Columns Header Settings”, select the column number and click on the 
appropriate field name from the two boxes respectively. For the data columns the 
selected field name should be the element code for the data under that column. Repeat 
for each column. Make sure the correct field names are selected for the data to be 
appropriately mapped in the database, 

(ii)  Once step (i) is completed the created header specifications can be saved in a text file 
to be used later for a similar file without going through the same process again. To save 
the header specifications click “Save Header Specs” and choose a convenient location 
and file, 

(iii) If the header specs had earlier been saved in a file then click “Load Header Specs” 
and select the folder that contains that file. If correctly specified, the columns in the 
displayed data table are labelled automatically as shown in Figure 64, 

(iv) Once the columns are correctly named click “Load Data” to start the uploading process. 
Wait until the busy mouse pointer changes to the default. A message is then displaying 
at the bottom of the dialog in red showing the data transfer progress. 

More details on the Command Buttons for the data import dialog are as follows: 
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Save Header Specs - Click Save Header Specs to save the header specification as a file for 
future use; 

Load Header Specs - Click on Load header Specs to load the saved header specification into 
your data to avoid typing the headers each time; 
View Data - Click View Data to view the data in a table view; 
Load Data - Click Load Data to start the uploading process;  
Clear - Click Clear to remove all the data from the table; 
Close - Click Close to close the dialog;  
Help - Click Help to get more information on the dialog; 
 

 

Figure 64: Multiple column data Import with column headers specification 

8.5 Importing Summarized Data 

Data that is summarized on Dekadal or monthly basis can be imported into Climsoft. In 
practice this done when the raw data for those summaries is not available. Otherwise it is 
advisable to import the actual observations because Climsoft is capable of producing those 
summaries whenever required. After importing the summarized values will be placed in the 
appropriate day of the month and be allocated a period value that is equivalent to the number 
of days used in the summary. For instance monthly summary values will be placed on the last 
day of the month and the period value will be number of days in that month. 

Following are examples of the summarized data with layouts: 
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Figure 64a Dekadal – Multiple Elements columns  Figure 64b Dekadal – Single Elements column 

    
Figure 64c Monthly – Multiple Elements columns  Figure 64d Monthly– Single Elements column 

 
The import procedures will differ with the layout of the summarized data as follows: 

(i) Data in multiple Elements Columns - Figure 64a and 64c 

From Welcome dialog follow: 
Data Transfer -> External Data ->Text File->Multiple Element Columns. Then check option 
Dekadal or Monthly for type of Figure 64a or 64c respectively. 

 

(ii)  Dekadal data in single Elements Column - Figure 64b  

From Welcome dialog follow: 
Data Transfer -> External Data ->Text File->Daily. Then check option Dekadal. 
 

(iii) Monthly data in single Elements Column - Figure 64d  

From Welcome dialog follow: 
Data Transfer -> External Data ->Text File->Monthly. 
 

Notes on Daily Data Import 
Trace Rainfall – Should be typed as 0T 
Missing Data – Should be left as blank. Any value that is not numeric will be regarded as missing data 
Cumulated data – Cumulated data should be type with C e.g. 200C. Values for preceding days be left blanks. 
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8.6 Importing Upper Air data 

Importing procedures for upper air data that has been digitized through other applications and archived 

in delimited text files is similar to files with surface observations data. The appropriate menus will be 

used depending on the layout of data in the files. The suitable menus are those for daily or multiple 

columns for elements. The only additional procedure is to indicate that the file contains upper air data 

through the corresponding check box. See Figure 64e below. 

 

 Figure 64e: Multiple element columns data Import for upper air data file 

8.7 Upload failures 

The data upload may fail due to various reasons. Error messages will be given on each case. 
As much as possible the messages should be studied carefully and the problems describe 
therein be addressed. In case of station or element in the data that had not been defined in the 
metadata the affected records will be skipped and the stations/elements listed at the bottom of 
the import dialog. The data should therefore be corrected and reloaded.  

8.8 Importing GTS data downloaded from NOAA – NCDC FTP site 

The NOAA-NCDC FTP site has a huge archive of GTS daily observation data from all synoptic 
stations around the globe. Most of the data dates back to the early 1970s. The data goes 
through some QC at NOAA-NCDC and is updated on a daily basis. The data is publicly 
available in compressed format. Climsoft has a facility for ingesting the unzipped data from 
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NOAA-NCDC. Figure 65 below shows a screenshot of sample data downloaded from the 
NOAA-NCDC FTP site: 

Figure 65: Sample data from NOAA-NCDC 

To import GTS daily data from NOAA-NCDC; 

(i) Select “Data Transfer” icon on the CLIMSOFT Welcome screen,  
(ii) Select “External Data” menu; 
(iii) 3. Select “NOAA GTS” to open the dialog and browse the data file as shown in Figure 66 

below. 

Figure 66: Importing data from a text file downloaded from NOAA-NCDC FTP site 

NOTE:  

b) A folder for GTS data must be configured under the “General Settings”. This is used as 
a working area by the Climsoft application during the process of importing the GTS 
data. If the MariaDB server is being accessed over the network from a workstation, it 
would be ideal to map that folder on the workstation for easy access or viewing from the 
workstation. However, the data to be imported can be placed in any location that is 
accessible via the “Browse” button. 

c) Since the GTS data would have gone through QC at NOAA-NCDC, the data is 
transferred to the “observationfinal” table. 
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9. Data Backup and Restore 
Data backup and restore are essential operations in data management.  

9.1 Data Backup 

9.1.1 Data backup by station 

Climsoft Version 4 has a facility for a complete backup of all the observation data in the 
“observationfinal” table by making individual backup files for each station. 

This process is fast and minimizes the computer memory resources. In addition it provides a 
quick view of the list of backup files in Windows File Explorer with the relative amount of data 
for each station by examining the file sizes, without the extra effort of doing a detailed 
inventory report (Figure 67). 

 
Figure 67: List of individual station backup files 
 

The backup dialog shown in Figure 68 is accessed by clicking the “Data Transfer” icon on the 
Welcome screen, followed by clicking the menu item “Backup”. 

     
Figure 68: Data backup 
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Browsing for the backup folder, then click the “Backup” button, for the backup process to start. 
The progress of the backup process is displayed. 

9.1.2 Complete database backup 

In Climsoft Version 4, the recommended tool for backing up the whole database is HeidiSQL.  
This is a graphical interface for managing databases that comes bundled with the MariaDB 
DBMS installation. HeidiSQL is easy to configure and use. 

Launch HeidiSQL either from the desktop shortcut or from the Windows Start menu under 
MariaDB program group. This displays the “Session Manager” as shown in Figure 69. 

  
Figure 69: HeidiSQL Session Manager           

The Session Manager in Figure 62 is to configure a connection to the MariaDB server. To 
setup a new connection, click on the “New” button on the bottom left corner of the dialog; 

After editing the “Session” name on the left panel of the dialog, specify the connection details 
on the right panel of the dialog; the required details include the IP address of the 
computer(server) where MariaDB is installed, the Port number, the user name and password; 

The Session Manager allows configuration of connections to more than one MariaDB 
installation on different computers. If MariaDB is installed on the local computer then the IP 
address should be “127.0.0.1” or “localhost” as shown in Figure 69. 

Completing the required connection details and click the “Open” command button (Figure 69), 
a screen appears with details of the database(s) and objects on the specified Port number, 
Figure 70. 
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Figure 70: HeidiSQL interface showing database information 

To carry out a complete backup of a required database, right click on the database name on 
the left panel of the dialog in Figure 70; 

A pop-up menu appears, click on the menu item “Export database as SQL”; this display a 
new dialog to specify details for the backup as shown on Figure71. 

Figure 71: HeidiSQL Dialog for database backup 

Click on the icon to the right of the filename to browse for the location and specify the filename 
for the backup.  
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To create a new database structure with all the tables and data, check all the check boxes on 
the right panel and select “INSERT” on the “Data” dropdown list. 

Click the “Export” button, the backup process starts and saves the backup file with the 
specified name (and the extension .sql), in the specified location. 

To restore the database (script file) click on “File” then “Load SQL file…”. Select the backup 
script file then click “Open” on windows explorer dialog and follow the subsequent dialogs. 

9.2 Data restore 

9.2.1 Data restore by Station  

The dialog for restoring data from individual station backup files is shown in Figure 72. This is 
accessed by clicking the icon “Data Transfer” on the Welcome screen followed by clicking on 
the menu item “Restore”. 

 
Figure 72: Data restore 

Browsing for the backup folder, then click the “Restore” button. The data restore process 
starts, showing the progress of the restore process. 

9.2.2 Complete Database Restore 

To recreate and restore the entire database from a complete backup, run the script of the 
backup file following the steps similar to those for creating a new database in MariaDB as 
described under Topic 2,paragraph 2.3 (Creating Climsoft Database in MariaDB and First 
Login). It is important to specify the exact name of the backup file in place of the name of the 
script file used for creating Climsoft Version 4 database in the first installation. 
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10. Climate Products 

10.1 Standard Products 

Climsoft version 4 provides a number of standard products which produce commonly required 
reports or diagrams using data contained in the main database. Products are obtained as 
follows. 

From the Welcome Dialog, click on the icon Climate Products or select Products on the 
main menu. The resulting dialog is shown in Figure 73. 

 

Figure 73: Products category list 

The categories of the products are listed after clicking on the list box. When a product category 
is selected then all the products for that category are then listed.  

For instance if category Data is selected, the product list under that category will be as shown 
in Figure 74; 
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Figure 74: Data Product list 

 

Details of different products type are listed in Table 3; 

No Products Category Product Types Details 

 
 

Data Hourly Summary of hourly observations 

Daily Summary of daily observations 

Pentad 5 Days summary 

Dekadal 10 Days summary 

Monthly Monthly summaries 

Annual Annual summaries 

Means Long term means 

Extremes Long term extremes (i.e. highest, lowest, dates of 
occurrences) 

Daily Extremes Daily Lowest and Highest values 

Monthly Extremes Monthly Lowest and Highest values 

Annual Extremes Annual Lowest and Highest values 

 Graphics Windrose Windrose picture 

TimeSeries Time Series Chart 

Histograms Histograms Chart 

 Inventory Inventory  Details of Data Records 

Missing Data Inventory of Missing Data 

Stations Records Time Series Chart for  total Observing Stations 

Yearly Elements Observed Yearly Time Series Chart per Station 

Monthly Elements Observed Monthly Time Series Chart per Station 

 Messages CLIMAT CLIMAT Messages 

 Output for other 
Applications 

Instat Daily data for Instat 

Rclimdex Daily data for Rclimdex 

CPT Data for CPT 

CDT Data for CDT 

GEOCLIM Data for GEOCLIM 

 Rain Days Dekadal, Monthly and Annual Counts of rain days with a specified threshold value 

 Upper Air Daily, Monthly and Annual Summaries for upper air observations at standard levels 

Table 3: Climate Products. 
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Once the product type is selected, the dialog for the corresponding products criteria appears. 
For instance if Monthly product is selected the dialog obtained is as shown in Figure 75. 

 
Figure 75: Data selection dialog 
 

The Station (s) and Element (s) are selected from the respective list boxes by their names, 
each one at a time. Deletion of undesired selections can be carried out for one item or the 
entire list using the commands provided at the bottom of each box. 

The relevant Summary Type and Period are then selected. The command “Start Extraction” 
is used to produce the corresponding products. Figure 76(a) and Figure 76(b), Figure 76(c) 
and   Figure 76(d) below give examples of data products output; 

Monthly TMax and TMin 

 
Figure 76(a): Monthly products 
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Extreme Values 

Figure 76(b): Extreme Values  
 
 
Extreme Maximum Values  

  
Figure 76(c): Extreme Maximum Values and Date of Occurrence 
 

Extreme Minimum Values  

 
Figure 76(d): Extreme Minimum Values and Date of Occurrence 
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10.2 Data Products for Other Applications 

10.2.1 Data for CPT 

 
 Figure 77: Output data for CPT 

10.2.2 Data for GEOCLIM 

 
Figure 78: Output data for GEOCLIM 
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10.2.3 Data for Instat 

 
Figure 79: Output data for Instat 

10.2.4 Data for Rclimdex 

 
Figure 80: Output data for Rclimdex 



 78 

10.3 Windrose Plot 

Windrose is plotted after selecting “Graphics” from the list of climate products category shown 
in Figure 73 above; 

The next step is to choose “Windrose” from the list, followed by the selection of the station. 
the system selects the wind speed and direction elements automatically. 

Specify the period range for the data to be used for the windrose plot.  

Click “Start Extraction” to generate the windrose plot as shown in Figure 81. 

The application used for plotting the windrose is WRPLot.  This application is free software but 
requires a licence that must be renewed annually. 

It is important to check that WRPLot was installed as part of the Climsoft installation and the 
licence for the application was registered. If WRPlot has not yet been installed, it can be 
installed using the setup file and the first licence file available in the “Bin” subfolder of the 
Climsoft installation folder.  

To renew the license visit the Lakes Environmental website at 
https://www.weblakes.com/products/wrplot/registration.html. Once you register your details and 
apply for the activation code, it will be sent to you by email within shortly. 

 
Figure 81: Windrose plot  
 

10.4 Plotting Charts 

Simple and basic charts can be plotted through the charts menu. There are two types of charts 
that can be produced namely, Time Series and Histograms. 
The charts are produced through the same procedures used in other products. It is 
recommended that each chart be plotted for data from 1 station only. 
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After Extracting data required for the chart a plotting dialog is displayed where the chart 
options will be provided. 
 

    
Figure 82: Charts Plotting Dialog 

 
For example to plot a Histogram chart, for monthly temperatures (Tmax and Tmin) from Wilson 
Airport, Kenya for the year 1984 do the following: 

(i) Check the option Monthly 
(ii) Type in the labels appropriately 
(iii)  Click the button Plot and obtain the chart below. 
 

 
Figure 83: Temperatures Histograms 

 
Similarly a Time Series chart for daily rainfall from Wilson Airport, Kenya for the period 1981-
1995 can be plotted as below. 
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Figure 84: Rainfall Time Series 
 

10.5 Inventory Products 

The inventory product retrieves details of the climatic elements that have been recorded at a 
particular station. When you click on the menu item Products -> Inventory or the icon 
Climate Products -> Inventory on the Welcome dialog, the following dialog is displayed: 
 

 
Figure 85: Inventory Products dialog 

 

There are 5 types of outs that can be obtained from the Inventory product. They are;  
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(i) Details of Data Records - Gives a tabulated output where a missing observation is 
represented by M and available observation by X. The procedure searches the database 
for the appropriate information and produces an Excel Spreadsheet as shown in Figure 87. 

(ii) Inventory of Missing Data – Gives the total number of missing observation records for a 
selected parameter in a given period of time. The output is displayed in graphical form as 
shown in Figure 87a. 

(iii) Time Series Chart for Observing Stations – Produces a time series chart for yearly 
total of stations whose data has been archived in the database as shown in Figure 87b. 

(iv) Yearly Elements Observed – Produces a time series chart for total observations per 
year for the selected elements from a given station. See Figure 87c 

(v) Monthly Elements Observed – Produces a time series chart for total observations per 
month for the selected elements from a given station. See Figure 87d. 

To produce any of these inventories select the required station(s) and element(s) from their 
respective list boxes as shown in Figure 87e.  

 

Figure 86: Input selection dialog for Inventory Products 
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Figure 87a: Inventory of Data Records 
 
 

Figure 87b: Total missing data records 
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 Figure 87c: Total missing data records  
 
 

 
Figure 87d: Annual reporting stations  
 

 Figure 87e: Monthly observations from station elements 
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10.6 Products from Upper Air Observations 

Dialog for products from Upper Air observations is obtained as follows: 
 
From the Welcome Dialog, click on the icon Climate Products or select Products on the 
main menu to obtain the products category dialog as shown in Figure 73. From the listed 
items Click on Upper Air to obtain the list of the available Upper Air data summaries as 
shown in Figure 88. 

 
Figure 88: List of Upper Air data summaries 

 

If any of listed products say Daily Levels selected (click) the following dialog is obtained. 

 

Figure 88a: Dialog for Monthly Upper Air data summaries  

The dialog shown in Figure 88a is similar to those for surface observations but with an additional list of 
upper air standard pressure levels. Any number of levels may be selected as desired  

Note that without selecting any Level no product will be obtained. 
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10.7 CLIMAT Messages 

CLIMAT message can be encoded from quality controlled data that has been uploaded to the final table 

of Climsoft database. 

Dialog for encoding CLIMAT messages is obtained as follows: 

From the Welcome dialog follow the menu 

Climate Products => Messages => CLIMAT. The dialog  

 

Figure 88b: Dialog to Encode CLIMAT message. 

 

The dialog is used as follows: 

(i) Select Stations – Stations whose CLIMAT message is required should be selected from the drop 

down list by clicking one station at a time. A station can also be selected by entering its station id 

then pressing ENTER key. The selected stations will be listed in the view list. 
(ii) CLIMAT message period –When the dialog opens the period is set to the previous month of the 

current date. It’s assumed that data for the previous month has been processed and ready for 

encoding. However, month for the required message should be correctly set. 
(iii) Climate base period– Begin Year and End Year of the period with suffient data to compute the 

climate statistics should be entered. A minimum of 30 years and the latest period define by WMO 

is recommended. On Clicking OK button the statistics for the selected period will be computed 

and stored in the database. It’s not necessary to compute them again unless date has been updated. 
(iv) Optional Sections – If required any of these sections can be included in in message when 

selected. Section 222 requires that suffient data to compute the Normal is available. 
(v) CLIMAT Message File – Encoded CLIMAT message will be saved in the indicated file. It’s a 

text file that be send via email as an attachement or pasted into the email’s message section  



 86 

11. AWS Real Time Data Operations 
 

This operation starts from the Welcome menu dialog. Click the icon AWS Real Time 
Processing to obtain the main dialog for Real Time Automatic Weather Station (AWS) data 
operations (Figure 89). 

Figure 89: AWS real time processing settings dialog 

 

Follow the steps below to begin the AWS data processing. 

11.1 Server Settings 

Click on “Servers” command on the left window of the dialog. The dialog through which the 
settings can be set is shown in Figure 90 
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Figure 90: AWS server settings 

These settings are for the servers that play the roles of AWS base station and message 
switching system that connects to the Global Telecommunication System (GTS). The 
commands Base Station and Message Switching are used to switch between the two server 
settings. Details required for the server settings should be obtained from the servers’ 
administrators and then entered. Multiple servers can be configured where more than one 
base station or message switching system is used.  

Click Add New to effect the changes.  

The details should be entered as follows; 

FTP Server Address – The FTP address e.g. 40.73.196.133 or the server network name; 

Input Folder: 

This is the subfolder in the FTP home directory of the server where data are located in the 
case of the AWS base station or where it will be copied to in the message switching 
system. If the subfolder is not in the root, the relative path should be indicated in accordance 
to the operating system rules. For example; AWS\input in windows and AWS/input in 
Unix/Linux; 

FTP Data Transfer Mode 

This is the login method allowed for data transfer by the target server. MS Windows based 
servers allow use of FTP. Some Linux based servers prefer the use of more secure data 
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transfer login methods such as SFTP. The method indicated by the target server should be 
entered here; 

 

User Name – Login name used to logon into the server, 

Password – Password for the user name provided, 

Confirm Password – The entered password to be confirmed. The Password is not saved until 
correctly confirmed. 

11.2 Sites Settings 

The stations whose data is to be processed are configured as follows; 

 Click the command Sites to give the dialog in Figure 91, 

Figure 91: AWS server settings 

 

Site details:         

 Site ID or Name as provided by the Met Service or obtained from WMO Vol A if already 
listed there, 

 Input Data file is the name of text file in the AWS base station containing data for the 
station listed in that current record. It should be ensured that the name matches the 
station’s AWS data file, 
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 Files name prefix if the data is in multiple files with a common prefix, the box before the 
“File name prefix” should be checked and the prefix filled in the text box. Otherwise, this 
should not be checked. 

In some special cases where filenames have date components, a date structured file 
name prefix may be used to selects files with observations for a day or a month. For 
instance for a filename such as 000001202008290000.txt the prefix will be entered as 
follows: 

yyyymmdd – To select all files for the current day’s observations 
yyyymm – To select all files for the current month’s observations 

For a filename such as 000001-2020-08-29-00-00.txt the prefix will be entered as follows: 

yyyy-mm-dd – To select all files for the current day’s observations 
yyyy-mm – To select all files for the current month’s observations 

 Data Structure is the name of the structure for the data output file in the AWS base 
station server. This is created by the user and corresponds to the data being transferred. 
Details on how to undertake this task are listed in Section 11.3.2, 

 Missing Data Flag is the value that represents missing data from the specified AWS 
server. This value will be obtained from files in the base station server; 

 AWS Server IP is the IP address or host name of the server; 

 GTS Msg Header is the Global Telecommunication System message header (e.g. 
HKNC for Nairobi) in case AWS Data are meant for sharing with others countries 
through the  regional or global centres, 

 Operational if a site has been created in the Climsoft database but has no operational 
AWS installed the box Operational should be unchecked, 

 Encode for GTS if a site has been created in the Climsoft database but does not send 
AWS to GTS, the box Encode for GTS should be unchecked. 

Commands: 

 To create new station in the database click Add New, enter all the details then click 
Refresh,  

 Update is used to save changes made on the details of an existing station, 

 Delete is used to remove the current station from the database, 

 View/Update enables viewing the sites in a table view. Editing can be done from there. 

11.3 Data Structure Settings 

Click the command Data Structures to obtain the dialog for updating or adding new AWS data 
structures used by Climsoft. 

Select any of the existing data structures e.g. aws_toa5_mg2 from the list box. Details of that 
structure are displayed as shown in Figure 92. Any desired changes will be done on the table. 
The changes made will be saved automatically. 
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Figure 92: AWS data structure settings 

To carry out the task of data structure settings, basic skills in BUFR and Climsoft elements are 
necessary. Configuration of the data structure is done as follows; 

11.4 Updating existing structures 

Changes can be made as may be desired. Real time processing of AWS data is based on 
structure of the data.  

This includes; 

(iv) Updating Bufr_Element – Only those elements whose BUFR element descriptors are 
entered will be encoded into BUFR messages. In case a new sensor is added and new 
observation started, its BUFR descriptor should be included. BUFR descriptors can be 
found in WMO BUFR Table B, 

(v) Updating Climsoft_Element – If an observation from any AWS element requires to be 
archived in Climsoft database, its Climsoft element code should be included. Climsoft 
element codes are contained in obselement table in the Climsoft database, 

(vi) Adding observation elements (record) 

To add a new element (a new sensor may be installed or activated) in the same structure, 
scroll on the table to the end of list and enter the details in the blank record. The values 
will be saved automatically, 

(vii) Delete Record 

Select the record by clicking at the left most cell of the record. It will become highlighted. 
Then press Delete key on the keyboard. The record will be deleted without any warning. 
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(ix) Structure Name, Delimiter Type, Total Header Rows and Text Qualifier 
Character may also be updated where necessary. In this case click Update to save 
changes. 

11.5 Creating a new structure 

Data from different AWS sites may come with different file structures. All different data 
structures should be created and allocated a name so that the received data is correctly 
mapped in the database. After studying the structure of data from a given site it is easy to 
create its structure as follows; 

Study and understand the new AWS input text file. Suggest an appropriate name for the new 
structure then enter the details in the text boxes in Figure 93; 

(iv) Structure Name – Name under which the structure will be known, 
(v) Delimiter Type – The character that separates data values e.g., Tab, comma etc. 

Select from the list, 
(vi) Total Header Rows – The number of header rows above the observation values, 
(vii) Text Qualifier Character – Where a character is used to qualify text values e.g. “ 

should be entered here. 

Click the command Create. A table is then displayed in Figure 90(a), from where details for the 
data columns in the AWS input file can be entered. 

 
Figure 93 (a): Dialog for creating a data structure 

Enter the necessary details in the table. Details of each data column in the input file should be 
entered as a record (row) in the table. The first column should have value 1 in field Cols. All 
the details of the data should be entered in the different fields of that record (row). The next 
row should similarly start with value 2 in the field Cols. This procedure is followed until each 
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column of the data from the output text file is described in this table. Information required in 
each record is as follows; 

 Cols - the position from left for the column being described, 

 Element_abbreviation – Abbreviation for the name describing data in the column.  

Users are free to use any type of abbreviation that describes the data except for the 
column with date and time values. The following abbreviations SHOULD be strictly used 
while abbreviating the date and time in the circumstances described below; 

Date/time - Date and time are in one column e.g. 21/03/2000 12:30:00 

Date - Date is in a column of its own e.g. 21/03/2000. 
Time - Time is in different column from Date e.g 12:30:00 
yyyy - Year is in a column of its own e.g. 2000 
mm - Month is in a column of its own e.g.03 
dd - Day is in a column of its own e.g.21 
hh - Hour is in a column of its own e.g.12 
nn - Minute is in a column of its own e.g.30 
ss - Second is in a column of its own e.g.00 
yyyymmddhhnnss -Date and time has this structure e.g. 20000321123000 
ddmmyyyyhhnnss -Date and time has this structure e.g. 21032000123000  
 

 Element Name – An appropriate name should be entered, 

 Climsoft_Element and Bufr_Element to correspond with the Climsoft and BUFR 
Elements as described in their manuals respectively. Where no value is put in these 
fields, data in the affected column will not be processed for Climsoft archival or TDCF 
encoding accordingly, 

 Unit – This is the unit of measurement of the values in the column. If the unit cannot be 
determined, it is left blank, 

 Lower_Limit and Upper_Limit – These values are used for Quality Control purposes 
so that Climsoft can flag outlier values for confirmation at a later time, 

 Obsv – Nothing to be entered in this field. It is used by Climsoft when processing the 
observation data. 

Figure 93 (b) shows data from an AWS text output file whose format is CSV with the character 
“as the text data qualifier. 
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Figure 93 (b): AWS Output Text File 

11.6 Coding Settings 

 

Figure 94: Dialog for setting TDCF message parameters 

The dialog in Figure 94 shows the settings required in BUFR message encoding. Most of the 
default values are automatically set at installation, but some are set by the user to meet the 
requirements for a particular NMHS. To undertake these settings knowledge of Table Driven 
Code Forms (TDCF) is necessary. WMO Manual on Codes is the main reference used for 
setting up the values here. 
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11.7 Data Acquisition and Processing Dialog 

 
Figure 95: Dialog for Data Acquisition and processing 

 

The AWS data processing is controlled from the dialog shown in Figure 92 and the information 
on the processing status is displayed. Before the process is started it is important that the user 
understands the role of each control shown in Figure 92. Details are as follows; 

Controls Details 

 Settings: 

o Restart – Starts the processing schedule, 

o Stop – Stops the process schedule, 

o Retrieval Intervals – The frequency in minutes at which the message encoding is 
repeated. Where encoding is required for Synoptic messages only the interval will be 
entered as 180 minutes. 

o Hour Offset – Time delay in minutes to start encoding after the time set for data 
downloading from data logger, 

o Timeout Period – The longest period in seconds that attempts to connect to the 
AWS server can be made before timing out the connection. If no time out period is 
desired a value of 999 should be entered. But in that case there is a risk of holding 
the process indefinitely if connection is not achieved at all. If connection speed is the 
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cause of the delay then a reasonable time out period should be entered e.g. 60 
seconds. 

o Delete Input File After Processing - When checked, the files containing AWS data, 
will be deleted from the base station server after processing, 

o GMT Diff +/- – The time difference between GMT and the time for the AWS data. A 
positive difference may not require entering a + sign but a negative one is mandatory, 

o Save Changes – Updates the changes made. 

 Processing information 

o Input FTP Server - AWS Base station from where data is retrieved for processing, 
o Input Files – List of the retrieved AWS text files, 
o Output FTP Server– Message Switching System to where encoded messages are 

sent, 
o Output Folder – Folder containing output files, 
o Message Files – List of the encoded and transmitted TDCF files. 

 Processing Status 

o Current Date and Time – Computer clock time. It should always be correctly set, 

o Retrieve last – Hours of data to be retrieved for encoding at each encoding 
interval, 

o Last Processed – Date and time of the previous encoding process, 

o Next Processing – Date and Time of the next encoding process, 

o Status – The current activity.  

 Error Messages 

Errors encountered during processing are listed here together with their time of 
occurrence. They are also logged into a file named aws_error located in the subfolder 
data of the Climsoft installation folder. 
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12. Paper Image Archiving 
 

Images of scanned paper records can be archived in Climsoft Version 4 and later retrieved 
when required. The operation starts by first creating the metadata for the paper image 
archives. Next set up the folder where the image files will be archived. The archived images 
files may occupy large amount of storage space hence it is necessary to choose a folder 
where sufficient space is available. The folder may reside in the local server or in a network 
connected server or Network Attached Storage (NAS). Where the archiving is done on network 
folder it is recommended that it be mapped as a drive on the local server for convenience of 
accessing the image files. 

The procedures for creating paper archive metadata are as follows; 

From the Welcome dialog click on the icon Metadata Information then on the tab Paper 
Archive in the subsequent dialog on Metadata Information. The final dialog is as shown in 
Figure 93. 

 

Figure 96: Dialog for creating paper archive metadata 

 Click on command AddNew to start the processing of adding a new metadata record, 

 The metadata to be entered are the Form ID which is the identification allocated by the 
Met service for that particular paper form. The details of the type of data contained in 
that form are entered in Description box, 
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 Click on command Save to save the metadata record, 

 Other commands are used as follows; 
o Update – Saves changes made on a metadata record, 
o Delete – Removes a metadata record from the database, 
o View – Displays metadata records in a tabular form. 

 
It is required that the location for archiving the image files be configured in the general settings 
of Climsoft. Follow the steps below to achieve that; 
 

 From the Main Menu click Tools -> General Settings and browse the records until the 
“Setting Description“ box displays the value; “Folder for Paper Archive image files”. 
See Figure 94, 

 
Figure 97: General Setting Dialog 
 

 Type the full path of the folder to be used for the image files e.g. 
C:\PaperArchive\Images then click the Update button. If the folder does not exist it will 
be created once the process of image archiving starts. When no folder has been setup 
archiving will still be possible but in a default folder that is in the path of the Climsoft 
installation. A message will be provided to that effect until the folder has been 
customized. 

12.1 Archiving Images 

The filenames for the archived imaged are structured such that they described the data in 
that file. Therefore Climsoft version 4 maintains a standard filename structure for the archived 
images files that it uses when an image for a particular observation is required for retrieval. 
Image files that come with the standard filename structure are archived straight away while 
those with a different structure are first taken through a renaming process. The following 
sections describe how images with different filename structures are archived. 

12.2 Archiving Images with Standard Filename Structures 

The Climsoft Version 4 standard filename is structured as; StnID-FormId-YYYYMMDDHH. 
The filename components are described as follows; 
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 StnID – Station identification code for the station whose data is contained in that image, 

 FormId – Identification code for the paper form as described in the metadata, 

 YYYYMMDDHH – Date, time and other special descriptions for the image as follows; 
o YYYY=Year, MM=Month in 2 digits, DD = Day of the month in 2 digits, 
o If the image contains daily data for the whole month DD=Last day of that month, 

and HH=Hour for the daily observations e.g. 06, 
o If the image contains hourly or synoptic data for one day HH=00, 
o If one particular observation is contained in different pages hence different image 

files then HH will instead be used as page numbers in 2 digits starting with 01. 

The procedure for archiving images with standard filename structure is as follows; 

(i) From the Welcome dialog, click on the icon Paper Archive to obtain the dialog 
shown in Figure 95, 

(ii) Click on the explorer button and select the folder containing images to be archived, 
All the image files will then be listed as shown in the dialog, 

(iii)  Uncheck the boxes for the image files that are not required. 
(iv) Click the command Archive to complete the process. 

           
Figure 98: Archiving images with standard filename structure   

12.3 Archiving Images without standard filename structured 

From the Paper Archive dialog shown in Figure 94 click the tab “Unstructured Filenames” to 
obtain the dialog shown in Figure 96: 
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Figure 99: Dialog for archiving images with unstructured file names 

(i) Use the explorer button to select and open the image file to be displayed on the dialog, 
(ii) Enter the details for the content of that image in the respective boxes in the dialog, 
(iii) The image may be rotated or zoomed so that the details are clearly seen. 
(iv) Click Archive to structure the filename and save the record, 
(v) Repeat the process for all the images to be archived. 

12.4 Retrieving and Viewing Archived Images 

Through Climsoft Version 4 records of the archived images can be browsed, opened, updated 
or deleted. Images saved in pdf format can also be viewed. To perform these tasks follow the 
procedures below; 

From the Paper Archiving dialog click the tab “Retrieve Images” to obtain the dialog shown in 
Figure 97; 

(i) Browse through the records as desired, 
(ii) Edit the records where necessary and click “Update” to save the changes, 
(iii) Select the “View Image” to open or view the image for the current record. 



 100 

 
Figure 100: Retrieved archived image 

12.5 Viewing a List of Archived Images Files  

To view the list of archived image files, click on the “Archival List” tab to open the dialog shown in 
Figure 97: 

 Figure 101: View the list of archived images 
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13. TDCF Encoding Operations 

13.1 TDCF Settings 

The settings below need to be in place in your system before sharing your data on Global 
Telecommunication System (GTS). To successfully configure Climsoft for this operation basic 
knowledge on WMO Table Driven Code Forms (TDCF) is required. Visit the WMO site for 
more details. The most useful reference documents are;  

(i) WMO manual on codes, 
(ii) Code tables, 
(iii) TDCF Templates and Common tables. 

Select the right template for your message and the message header as per the NMHS then 
enter the message indicators. Enter the Automatic Message Switching System (AMSS) details 
were the messages will be rooted as shown in Figure 99. Click Update to save changes in 
each case. 

 
Figure 102: TDCF Settings 
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13.2 Synoptic data entry form for TDCF encoding 

 
Figure 103: Synoptic Data for many elements for one observation time - TDCF Form 
 

The rules for entering observation values are as follows; 

(i) Pressure Data – In Hpa and multiplied by 10 to remove the decimal point, 

They are: 

 Station Level Pressure (SLP) 

 Seal Level Pressure (MSL). To be entered as missing in stations above 500 M altitude 
and ; 

 Pressure Change (3Hr and 24Hr) – To be entered as missing when not observed 

(ii) Three (3) Hr pressure change characteristic - Code figure to be entered as described in 
the Manual on Codes.  

 Code figure 2 shall be used for positive tendency; 

 Code figure 7 for negative tendency; and  

 Code figure 4 for no change  
(iii) Standard Pressure Level – In Hpa as a whole number and NOT multiplied by 10 e.g. 850 
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(iv) Geopotential Height – In whole number of geopotential metres (gpm), 
(v) Temperatures – In degree Celcius and multiplied by 10 to remove the decimal point,  

They are: 

 Dry bulb - observed at synoptic hours, 

 Wet bulb - observed at synoptic hours, 

 Dew point - observed at synoptic hours, 

 Minimum - recorded only at 06Z, 

 Maximum – recorded only at 18Z, 

 Grass minimum – observed at 06Z. 
(vi) Relative Humidity – In whole number of percentages, 
(vii) Visibility – Tens of meters, 
(viii) Total Cloud Cover – Oktas. Climsoft will encode value into percentage of total cloud 

cover, 
(ix) Vertical Significance – Code figure for the appropriate vertical significance, 
(x) Low level Cloud Amount (Nh) – Code figure for the amount lowest cloud level, 
(xi) Cloud Base Height (h) – Height in tens of metres for the base lowest cloud level, 
(xii) Low Level Cloud Type (CL) – Code figure for Low Level clouds type, 
(xiii) Medium Level Cloud Type (CM) – Code figure for Medium Level clouds type, 
(xiv) High Level Cloud Type (CH) - Code figure for High Level clouds type, 
(xv) Individual Cloud Layers – Vertical significance, amount, type and height of individual 

cloud layers that qualify should be entered in their appropriate boxes in the order they 
occur. When less than 4 layers are reported the remaining boxes should be left 
untouched or flag value M be used, 

(xvi) Present Weather, Past Weather (1) and (2) – Code figure for the appropriate weather 
description, 

(xvii) Evaporation – Kgm/M-2 multiplied by 10 to remove decimal point, 
(xviii) 24hr Sunshine – Number of hours multiplied by 10 to remove decimal point, 
(xix) 1Hr Sunshine – Number minutes in whole numbers, 
(xx) 3hr Rainfall – Amount accumulated for the last 3 hrs in Kgm/M-2 multiplied 10 to remove 

decimal point, 
(xxi) 24Hr Rainfall – Amount accumulated for the last 24hrs in Kgm/M-2 multiplied 10 to 

remove decimal point, 
(xxii) Wind Direction – Degree from True North in whole numbers, 
(xxiii) Wind Speed – M/S multiplied by 10 to remove decimal point, 
(xxiv) Radiation – MJ/M-2 multiplied by 100 to remove decimal point. 
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13.3 TDCF BUFR Encoding 

When data entry for the synoptic hour is finished, click the button TDCF. Then use the Encode 
button to encode your data into BUFR codes as shown in Figure 101. 

 
     Figure 104: TDCF Processing 
 

 Click the Send button to send to share your message with the Regional Telecommunication 
Center for forward transmission to Global Telecommunication System (GTS). You can also 
view the content of your message in csv format by clicking on the button View Descriptors. 
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